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1. Create a simple database 
 

1.1 – Design a simple database, with at least two tables, using a database 
application, basic design principles, software functions and simple formulae 

Databases 
A database is a collection of data that can be viewed, changed and updated. Databases can be used 
to record and track a wide variety of information such as sales, customers, products and finances. 
However, the purpose will vary depending on the organisation using it.  

Databases are used in most organisations to track the company’s resources and business activities, 
and ensure they are effective. Reports may be created from the information held in the database in 
order to judge whether this has happened or not.  

Microsoft Access is a software programme that is purpose-built to create databases, and all the 
examples in this unit will be assuming you are using it. However, other databases will have similar 
principles. Microsoft Excel is also a popular software choice as it requires fewer skills to use. 

Databases may be used to: 

 Record customer information 

 Track orders and purchases 

 Manage relationships with customers 

 Analyse past and future trends 

 Record personnel information. 

Design principles 
Formatting the database may require design changes such as naming, data layout and formatting. 
Cell sizes can be changed by moving the mouse to the top or side of the page where columns start, 
known as field names, and clicking and dragging.  

Microsoft Access can be used in a range of views: 

 Datasheet view 

 Design view 

 Layout view 

 PivotChart view 
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 PivotTable view. 

The different purposes of these will be explained throughout the unit. To switch between them, 
choose from the icons in the bottom-right hand corner of the screen when a table is open. Hovering 
over them will show which icon is which. 

Objects can be added to a database to record or analyse data. These include tables, forms and 
reports. 

Tables 

Large amounts of information quickly get confusing, so they are arranged in tables to make them 
easier to understand. Before you start building a database, you should plan which tables will be 
contained within it, and whether they will need to relate to each other. This will prevent you from 
deleting redundant tables or creating additional ones later. In a Microsoft Access table, columns are 
known as fields (or sometimes attributes) and rows are records.  

To create a table, open a blank database, choose a file name for it and click Create. You also import 
external data to create a table by selecting the Import and Link button under the External Data tab. 
This will allow you import data from an Excel spreadsheet, another database or an XML file.  

Each table has properties which can be edited to change how the data is stored within it. The 
properties can be accessed by opening the Design View, clicking Show in the Design tab, and 
selecting General. A box will appear with options relating to the display, behaviour and appearance 
of the database. 

Forms 

Also known as ‘data entry screens’, forms are used to view, enter and edit data in the table. It is 
possible to work without them by editing data directly on the table datasheets, but most people find 
a former easier and less confusing to use. It is likely to be one of your tasks to enter data into forms 
before producing a report with it.  

Each table will probably have a different form with different data entry requirements. For example, 
an ‘Order Form’ would allow you to record information about a particular purchase a customer has 
made, which would then enter into the system. To ensure that data is entered correctly, you can 
format the form so that only certain boxes can be written in, or that certain requirements must be 
fulfilled before it is completed.  
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Creating a form can be done in several ways. The simplest way is to select the table you want to 
enter data into, choose the Create tab and click Form.  

To create a blank form not belonging to any table, click Blank Form instead. You can then select 
fields as data entry points by double-clicking or dragging them.  

Queries 

Queries are essentially requests for information from the database, which allow you to perform 
many functions such as adding, changing, reviewing or deleting data. They can also filter or 
summarise it. They are useful in that they can pull together information from multiple tables. You 
will be required to have a strong grasp of queries when working with databases. 

There are several main types of queries: 

Query name Function 

Action queries Add, change or delete data 

Select queries Retrieve data or make calculations 

Append queries Adds new records 

Delete queries Delete whole records from database 

 

One of the most common uses of queries is to review subsets of data within a table. To do this, 
select the Create tab and click Query Design. On the Tables tab, select the table that the data you 
want is contained within. Then double click the fields you want to analyse. To run the result, open 
the Design tab and click Run. This will return your information which you can analyse. 
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To review data from multiple tables, start the Query design as normal. Once you have selected one 
field, select the other table and add the field from that. Repeat this process as many times as 
necessary. You can also set criteria (for example, in product type you may only want it to return 
‘electronics’.) To do this, click on the appropriate column and type your specification in the Criteria 
row. This will allow you to produce more complex queries. 

Some queries are ‘updatable’ meaning editing the data in the query sheet will update the original 
data. Be aware of this when assembling the report.  

Reports 

Reports are a way to summarise information in databases that you may have obtained either from 
tables or queries. These can provide broad summaries of multiple tables or detailed breakdowns of 
individual records. The purpose of a report is usually to present data in a clearer way which may. 
Creating reports will be explained in more detail later in the unit. 

Formulas  
Formulas are used to perform calculations 
automatically. They are known as expressions in Access. 
They are particularly useful when information may 
change as they will be continuously calculated; when the 
original information changes, so will the answer. 

Excel formulas 

Formulas in excel are written directly into the cells. Every 
formula starts with an = signs. You can perform calculations such as averaging, addition, 
multiplication and counting. For example, if you wanted the cell to have the total of cell B2 and E3 
added together, it would be written: =B2+E3.  

Function Formula 

Multiplication  = A1*A2. 

Several cells can be multiplied together, such as: =A1*A2*A3. If there 
are a lot of numbers in the range, it may be quicker to write it as 
=PRODUCT(A1:A3). 

To multiply the answer by other numbers, you can also write 
=PRODUCT(A1:A3,2). 

Average The mean average is calculated by adding the numbers together and 
dividing by the number of pieces of information. 

=AVERAGE(A1:A3) 

Division =A1/A2 

Maximum and minimum These return the largest or smallest pieces of data from the selected 
range. 

=MAX(A1:15) or =MIN(A1:A5) 
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Count To workout the number of cells that contain numbers within a given 
range, use =COUNT(A1:A5) 

Sum To add together numbers, such as whole columns or rows, use 
=SUM(A1:A4). 

Subtraction =A3-A2 

 

Access expressions 

In Microsoft Access, expressions are used to produce a logical or mathematical outcome in forms 
and reports. They can calculate values or check data for values. Like Excel, each expression starts 
with an = sign. 

To enter them, have the report or form open in Design view and right click the text box where the 
expression will be, then click Properties. In the pop-up box, type the expression you want in the 
Control Source box.  

Expression Result 

=Avg([Order]) This expression will find the average value in the order field. 

=Count([Order]) This expression counts the number of pieces of data in a particular 
field and displays it as a number. 

=Sum([ShippingCost]) The sum function adds the pieces of data together. This would produce 
the total of all shipping costs. 

=[FirstName] & “ “ & 
[LastName] 

This expression will display the results for the two fields in square 
brackets, in this case someone’s first and last name. The space in 
quotation marks ensures there is a space between the fields.  

=[Page] Used in headers and footers to automatically display the page number. 

=[ProductTotal] + 
[ShippingTotal] 

This performs a mathematical equation by adding together the two 
values, assuming they are correctly formatted. It should display the 
result as currency. 

=[ProductPrice]*[Quantity] This expression multiplies one field by the other, in this case to 
produce an overall price. Fields can also be multiplied by numbers. 

=[TotalPrice]/[Quantity] The / symbol acts as a division symbol, which would produce the 
average price per product in this case. 

 

Expressions can also refer to fields in other forms or reports by writing it as: 
=Forms![Personnel]![Personnel]. This will return the value for that field.  
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Relational databases 
Relational databases are ones that are connected through a relationship between pieces of data. 

Often in tables, there will be excess information that is redundant for the purpose. Relational tables 
divide these into smaller, connected tables that only contain the relevant information. This is 
referred to as normalisation. 

Databases with all the information recorded in just one table are flat file databases. They cause 
problems when trying to edit or delete information. For example, this database records employees 
who work at a company, along with their employee number and department. 

 

 

Imagine the Sales department changes its name to Commercial. To change this in the database, each 
individual cell with that word would have to be changed. This could be made more efficient if the 
table was relational with another one. 

Employee no. Name  Department code 

101 Ben 10 

102 Mark 20 

103 Allison 30 

104 Aaron 20 

105 Ken 30 

106 Beth 20 

107 Helen 10 

  

Employee no. Name  Department 

101 Ben Marketing 

102 Mark Sales 

103 Allison IT 

104 Aaron Sales 

105 Ken IT 

106 Beth Sales 

107 Helen Marketing 
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Department code Department 

10 Marketing 

20 Sales 

30 IT 

 
Now the department name could be changed simply by adjusting the name in the Department Code 
table. For example, you can now see Allison works in department 30. Cross-referencing this reveals 
that department 30 is IT. The data is now structured more efficiently and is easier to edit. The 
method of creating relationships will vary depend on the programme the database is stored in. 

1.2 – Develop a table with fields and attributes according to database usage, 
as well as data considerations and user requirements 

Database fields 
A database field is the name for a column. The data could be a name, date or a monetary value. Each 
of those is a different type of data.  

Columns in an Excel database are also known as fields. Headings (called field names) are used to 
identify the data contained below. For example, the field names from the table in Chapter 1.1 were: 

Employee number Name Department 

 

Using these ensures the correct data is always recorded in the same column.  

Data fields can be formatted to hold different pieces of data, which affects the overall size of the 
database. To change the data type, open the Datasheet view, click on the column and then use the 
drop down menu to select the correct type. Often Access will correctly determine the type of data, 
but may get confused between time and currency, for example.  

Different types of field include: 

 Text fields 

They can hold any type of characters and 
up to 255 characters of text. To improve 
the database’s speed, limit this to a 
reasonable amount. For example, 
surnames are very unlikely to exceed 20 
characters. 

 Numeric fields 

They can only hold numbers which aren’t monetary, which may be either positive or 
negative. Whenever you will use the data to perform a calculation, record it as a 
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number field. If the numbers will always be whole integers, format the field to 
remove ‘floating’ decimal points at the end. 

 Date and time fields 

These are used to store dates and times, although the exact format can vary, e.g. 1st 
January 2015 and 1/1/2015. It is important to be consistent to ensure no errors are 
made. A range of predefined formats are available to record long, medium or short 
versions of both dates and times. 

 Currency fields 

This is used for calculations relating to money, and allow up to four decimal places 
to the right to ensure it is accurately recorded. 

 Hyperlink fields 

Hyperlink fields are used to store email addresses or Internet URLS. 

 OLE fields 

These fields attach OLE (object linking and embedding) objects such as Excel 
spreadsheets. However, only one object may be attached to each record. 

 Yes/No fields 

They fields require an answer that must be either yes/no, on/off or true/false. 
These answers are known as Boolean data.  

It is also important to be consistent when entering data. For example, entering numbers as both 
letters and numbers (ten and 10) will produce incorrect results. Choose beforehand which you will 
use. 

If you are unsure which field is appropriate, use the smallest and simplest field which will hold the 
data. For example, dates can be held by the data fields so there is no need to use a numeric field, 
which will take up more space. Similarly, use a numeric field for numbers rather than a text field. 
This will save space in the database, which may be important if it becomes quite large. 

Other ways to improve database performance are: 

 Normalising the database wherever possible to only record data one 

 Limit primary keys to one field 

 Delete subdatasheets that are created between related tables 

 Don’t add unnecessary indexes, just enough to create primary keys. 

As you use more functions of a database, other ways to improve database performance may also 
become relevant: https://msdn.microsoft.com/en-us/library/dd942824(v=office.12).aspx  

https://msdn.microsoft.com/en-us/library/dd942824(v=office.12).aspx
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Attribute 
An attribute can refer to two things:  

 A single component such as a table or database field 

 A characteristic of table that affects its behaviour. 

You can add more database fields to an existing table. If you want to enter the 
data by hand, click on the Add New Field button to the right of the table and 
begin entering information. You can edit the field’s name to reflect the 
information. 

You may also choose to choose from a pre-defined list of fields beforehand, as 
many databases share similarities. Choose the one that fits your needs most 
closely. To choose from the list, have the table open in Datasheet View open 
and press New Field in the Fields & Columns group. Select the fields that you 
want and drag them onto the table. 

For example, under the Events tab are field names such as: 

 Title 

 Start time 

 End time 

 Location 

 Description. 

If you have never created a database before, these will give you an idea of the information you will 
need to record. You can remove or add fields to customise it, or rename columns by right clicking on 
the heading. 

You can also add fields from other tables. Open the table you are working with in Datasheet view. In 
the Datasheet tab, click Add Existing Fields. This will display the possible fields, which you can drag 
onto the table like in the previous example. Note that this may create new relationships between 
tables. Be cautious of this if the two tables are unconnected. 

1.3 – Create a primary key for each table 

Primary key 
A primary key is a unique piece of information for a record. It acts as an index, giving each record a 
unique number. For example, there may be several John Smiths in an organisation, but if they were 
each given a unique Employee number, they would be easily recognised in a database.  

It is important to remember that there can only be one primary key in a table. It may be generated 
specifically to identify records, or it may be a normal attribute that is always unique for 
administration purposes. 
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A primary key in one table can be used to create a relationship with another table, where it is called 
a foreign key. This connects the tables together to share data. A table can have any number of 
foreign keys. 

A common example in business is customer databases. There is usually a database of customers, 
each with their own unique ID number, which is the primary key. This ID number is then used to 
create a relationship with the Orders table, where it is considered a foreign key. If orders were 
recorded by the customer name, items risk being delivered to the wrong customer with a different 
name. When using unique primary keys, there is never any doubt. 

  

Foreign keys are different from primary keys in that a table can contain more than one and they are 
not necessarily unique. They cannot always identify a record either; for example, you wouldn’t be 
able to tell which record is which by looking at the customer ID number in the Orders table. This 
would require you to cross reference it with the previous table. 

To create a primary key in Access 2010: 

1. Select the database that needs a primary key 

2. Find the Navigation Panel. (If you can’t see it, press F11)  

3. Right click the relevant table and click Design View 

4. Choose the field that will be the primary key. (To choose more than one, hold CTRL 
and click the appropriate fields) 
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AutoNumber 
AutoNumber can be used as a type of primary key in Access 2010 and other programmes. For 
example, the employee numbers in Chapter 1.1 may have been generated by using the AutoNumber 
feature. 

Only one AutoNumber field is allowed per table. It is useful when generating large amounts of 
numbers instantly, for example, for every customer in the organisation database. This would be a 
laborious task by hand. 

To create AutoNumber: 

1. Open the appropriate database 

2. Find the Navigation Panel. (If you can’t see it, press F11)  

3. Right click the relevant table and click Design View 

4. Click on the first empty row 

5. Type a name for the AutoNumber in the Field Name field, e.g. Customer ID, PIN, 
Order Number 

6. Click the arrow up the Data Type field and press AutoNumber 

7. Click New Values then Field Properties and click: 

o Increment to use incremental numbers (e.g. going up by one each time) 

o Random to use random numbers. 

Your choice of incremental or random numbers will depend on the purpose of the database. For 
example, incremental numbers will help you to track back through it easier, although random 
numbers might be better for customer protection reasons. 

A table will automatically be created with a primary key. However, you may change or remove it. To 
change it, select the fields in Design View, open the Design tab and click Primary Key. 

To see the relationships within a table, click on the Database Tools tab, and then Relationships. This 
will display which tables are connected. You can delete them from here by clicking on a line between 
two tables and pressing Delete. 

 

1.4 – Modify table layout and field attributes as required 

Table layout 
You may be required to edit the table layout in order to make information clearer or edit 
information. It affects not just the presentation of the table, making it more visually appealing, but 
the functions as well. 

Modifying it may include: 
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 Setting gridlines on or off 

 Adding columns or rows to table to add additional information 

 Deleting columns or rows 

 Aligning the content in a table (e.g. left, right, centre) 

 Changing the spacing in a table 

 Modifying the font or size used for text 

 Changing the background colour. 

The method of modifying tables will vary depending on the programme you are using.  

In Microsoft Access, right clicking on a field name in Datasheet view will allow you to delete, rename, 
hide or inset the field. You can also change the width to ensure all information is visible through a 
pop-up box. The Font Pane, under the Home tab, will allow you to adjust the writing colour, size and 
font. The symbol beneath the font size menu will also allow you to set the gridlines on, off or any 
mixture of the two. 

You may need to create columns and fields to contain details such as: 

 Customer details (e.g. names and addresses) 

 Financial information such as: 

o  balances 

o card numbers  

o invoices 

o prices 

o dates 

o paid or unpaid information. 

Modify the table to ensure you have the correct number 
of fields and records, and they can correctly display the 
information you are required to show.  

1.5 – Create a relationship between the two tables 

Relationship between tables 
Database systems like Microsoft Access can easily establish relationships between tables.  

To create relationship between tables: 

1. Click on the Database Tools tab and then Relationships 
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2. The Show Table box will appear if you haven’t defined any relationships yet. You 
can filter it to view tables, queries or both. For this exercise, click Tables 

3. Select two or more tables, then click Close 

4. Select the field you want to become the primary key. Drag it to foreign field in the 
other table 

5. An Edit Relationships box will appear. Confirm that the field names are the ones 
that you want to create a relationship between (e.g. ID in the Customers table and 
Customer ID in the Orders table) 

6. Confirm that the field names are correct. If they aren’t, click on the field to edit it 
and chose the correct one 

7. If you want each value to transfer exactly over (as in this case), check the Enforce 
Referential Integrity box. Otherwise, leave it unchecked 

8. Click Create to establish the relationship.  
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Referential integrity 

Referential integrity ensures that related tables are consistent. It prevents to addition of a record in 
a table with foreign key that doesn’t appear in the table with the primary value. This is important so 
that Employee ID numbers or order numbers can’t be mistyped. 

To maintain consistency, some referential integrity rules cause deleting a record in one table to 
delete it in the other. This is known as cascading delete. The same applies with cascading 
modification, where changing one record causes all linked records to be changed. 

 
Table A 
(Primary key)  

Table B 
(Foreign key) 

1  1 
2 

 

2 
3  5 

 

For example, 1 and 2 are acceptable in Table B because they appear in Table A. However, 5 isn’t a 
valid because it doesn’t appear in the primary key.  

Types of relationships  
One-to-one  

In the tables above, there was one primary key and one foreign key in the tables. This is known as 
one-to-one relationship. It occurs when there is exactly one matching record for each table. 

This type of relationship isn’t commonly used as it can be combined into a single table unless it 
creates redundant information. However, it may be relevant when a table with many fields is divided 
for security reasons or ease of use. 

One-to-many  

In this case, one primary key relates to multiple foreign keys in the related tables. Therefore, 
changing information in the primary key will produce multiple changes. The field on the primary 
must be unique. When editing the Indexed property for this field, set it to ‘Yes (No duplicates)’. The 
field on the foreign key side should not have a unique index; the Indexed property should be set to 
‘No’ or ‘Yes (Duplicates OK)’. This will allow Access to create a one-to-many relationship. 

These may occur in customer order tables; the customer order number will be unique in one table, 
but they can place multiple orders that will make duplicates acceptable in the connected table. 

Table A (Primary key) 
 

Table B (Foreign key) 

1 
 

1 

2 
 

1 

3 
 

4 
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Many-to-many 

Records in both tables relate to multiple records in the other table. Both sides must not have a 
unique index, which requires setting the Indexed Property to ‘No’ or ‘Yes (Duplicates OK)’.  

These require an associate table (also known as a junction or a linking table) to allow them to 
function correctly. This will contain the primary key from each table to establish them, effectively 
making two one-to-many relationships. 

A relationship like this may occur in a complex set of databases such as a Product and Order 
database. Each product may be contained within any number of orders, and each order may have 
any combination of products. 
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1.6 – Check and amend data entered, in accordance with organisational and 
task requirements 

Check and amend data 
After data is entered into a database, you will need to check its accuracy and amend it where 
appropriate. Be aware of the aims of the task you are performing what correct data will look like.  

Checking data involves: 

 Checking the accuracy of data 

It will be necessary to ensure the data you have entered reflects the information 
you were provided with. Confirm it against paper records or earlier databases. 
When data is entered manually, mistakes always occur, no matter how carefully it is 
done. 

 Checking the formatting 

Ensure that data is entered in the correct format. For example, numbers should 
always be written numerically, while there are several different ways of writing 
dates. Look at the Database Fields discussed in Chapter 1.2 to determine the correct 
one. 

 Proofreading 

Check text for spelling and grammatical errors. Spell-check functions can be useful, 
however make sure you read it to confirm.  

 Checking the accuracy of formulas 

You can’t always trust the accuracy of formulas. Confirm them with a calculator to 
make sure they are producing the desired answers; if not, check the data you have 
entered and mistakes in the writing of the formulas, such as the cell names. 

Data produced by databases is always inaccurate if the data that is put in isn’t accurate; therefore it 
is important to be as careful as possible when inputting data. Follow any relevant organisational 
procedures to help improve your accuracy.  

If you find inaccurate data, amend it and check similar pieces of data to ensure it wasn’t a recurring 
mistake.  

When inputting data for long periods of time, ensure 
you are set up to work properly, such as sitting 
comfortably at your desk with no distractions. This will 
help you achieve the highest possible accuracy. 
Research whether there are any organisational 
requirements relating to this to achieve the company’s 
desired standards of accuracy.  
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2. Create reports and queries 
 

2.1 – Determine information output, database tables to be used and report 
layout to meet task requirements 

2.2 – Determine data groupings, search and sort criteria to meet task 
requirements 

Reports 
Reports are a common way of producing information from a database query. They can present the 
results clearly, often with visual representations like graphs, and can be printed off, exported to 
another programme or used in presentations to educate the listeners. They are often used to inform 
decisions.  

When you are preparing a report, it is important to determine what information is needed and 
which database you will need to access it, known as the source. Before running the query, you may 
need to change the layout or contents of database.  

Queries may answer questions such as: 

 How are sales performing this year? 

 Where are our customers located? 

 How has this product performed? 

Determine exactly what question you need to ask and the information you will need to answer it. 
Whether it is straight forward, such as a list of customers, or complex, such as a detailed breakdown 
of sales, you must first locate the data. 

Microsoft Access contains a feature called Report Wizard which can walk you through creating a 
report by asking questions to determine the result you want. You can select how the data will be 
organised and displayed. 
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Data groups 
Microsoft Access can perform reports to group data by values. The groups are editable, so if you 
choose to group customers by age, you would be able to select the groups you wanted (e.g. 16-25, 
26-35, 36-50, 51 and over.) This allows you more flexibility in defining the groups. 

It is important to select groups that will provide the data you need for the report. If the report is 
about sales in a certain city, make sure to exclude all data that doesn’t relate to that city.  

To sort through the data, click ‘Add a sort.’ Select a field from the list, and the Layout view will allow 
you to review the changes. You can continue adding grouping levels and sorting requirements until 
you are happy with the appearance of the data. This often makes it simpler and easier to understand 
than in its raw form.  

When adding multiple sorts, records are sorted from the outmost field (the one on the left) to the 
innermost field (the one of the right). You can adjust this order to choose which field should be given 
priority. 

Tables, queries and forms can also be sorted. Right click on the innermost field and click on the 
relevant sorting, which will depend on the data type. For example, text could be sorted 
alphabetically, numbers could be sorted by size and dates could be sorted oldest to newest or vice 
versa. Repeat the steps moving up towards the outermost field. 

Records can be sorted by: 

 Customer’s name 

 Product ordered 

 Value of order 

 Date of order placed 

 Delivery destination 

 Product category. 

This allows you to thoroughly sort through the data before running a report or query. If you choose 
to remove a sort order, find the Sort & Filter group and click Clear All Sorts. 
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2.3 – Run reports and queries to check results and formulae provide the 
required data  

2.4 – Modify reports to include or exclude additional requirements 

Running a query 
To run a query, click on the Create Tab and then Query Design. In the pop-up box, open the Tables 
tab and select the field you want to draw data from. Once you have closed the box, you can click on 
Field Names to add them to the query. When you are ready, click Run in the Design tab. 

You can add parameters to narrow the data in existing queries by editing the criteria of them. This 
can be done by opening them in Design View and clicking Parameters in the Design Tab. Add a value 
for each parameter you want to match to. For example, if you are looking for employees with the 
last name Smith, you would type that in the LastName field.  

Running a report 
To create a report in Microsoft Access, you should: 

 Choose a record source such as a table or a query 

 Choose the tool to create it. You can choose 
from: 

o Report, which opens a simple report 
containing the fields 

o Report Design, which allows you to add 
extra fields and controls 

o Blank Report, which creates a blank 
report in layout view to allow further 
editing 

o Report Wizard, which walks you through to process of specifying fields and 
layout 

 Click Create to produce the report. Navigate through the Wizard if you selected that 
and press Finish.  

Modifying the layout 
You can modify reports to change the presentation by: 

 Adjusting the size of fields and labels 

 Moving a field to a new location 

 Spitting, merging or deleting fields. 

You can modify reports through either Layout or Design view. Although both are usable, some tasks 
are easier in one than the other. 
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Layout view is useful for rearranging the fields, changing their sizes or any other task that requires an 
overall view of the report. It is also useful for applying custom styles. In Layout view, it is also 
possible to see the data while you make design changes. Also, only Layout view can be used to make 
changes to the table layout of web forms using HTML. In addition, the view allows you to split 
columns and cells like you would tables, which makes rearranging them easier. 

Design view allows you to more easily format each area of the report, such as adding, positioning, 
formatting, and manipulating the fields. This includes adding text boxes of the date the report was 
run, which is useful when dealing with rapidly changing data.  

It is important to be familiar with both layouts and change between them when necessary. You may 
receive a message when trying to perform certain functions telling you that you need to switch 
views. 

You can switch between views by: 

 Right-clicking on the report’s document tab and selecting the appropriate view from 
the menu 

 Right-clicking on the report in the Navigation panel and selecting the view from the 
menu 

 Clicking on the View button in the Home tab, and switching between available 
views. (Note: clicking the arrow under View will drop down a list of available views.) 

3. Use database 
 

3.1 – Ensure data input meets designated timelines and organisational 
requirements for speed and accuracy 

Deadlines 
It is likely that you will have to work towards a deadline when using databases and creating reports. 
It is important that you know when this deadline is and leave sufficient time to complete it even if 
the work takes longer than expected. 

Deadlines may be: 

 Organisational deadlines, such as a meeting 

 Informal deadlines agreed with colleagues 

 Formal deadlines required by customers or clients. 

Check with a supervisor to see if your organisation has any relevant policies regarding deadlines.  

 

Deadline policy example  
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Reports of marketing data must be created within five working days of the end of each month. This 
will provide staff with sufficient time to process the data accurately and produce a report up to the 
company standards. If for any reason the marketing data is late in being received, a reasonable 
extension can be agreed with the relevant staffs’ supervisor. 

 

Be aware of relevant deadlines. If they will impact on others in the 
organisation, (for example, if you will be unable to work on a team project 
on a specific day), you should inform your colleagues beforehand.  

Ensure that you understand what is required of you by the deadline. While 
most months this will be consistent, sometimes your workload may 
fluctuate due to seasonal variations, activities or events. Investigate this 
beforehand to ensure you leave enough time to finish before the deadline. 
If you are unsure how long an assignment will take, it is better to start it 
early. 

Be aware how much time you can be delayed by before you will miss your deadline. If you don’t 
believe you will be able to meet a deadline for whatever reason, it is important to explain this to 
your supervisor as soon as possible. An alternative deadline may be arranged, or you may have to 
show what you have completed by that date. Informing others will allow people to work around you. 

Raise issues speedily if you encounter technical problems. Developing your own skills will also enable 
you to tackle these problems yourself and increase your data inputting speed. 

Reviewing the data 
Once you have inputted the data, take time to review it to match sure it matches what you would 
expect. Consider whether there appears to be more or less than you thought there would be, 
whether any information is duplicated or if it is in the correct format. 

If there are any problems, you should attempt to solve them now before you proceed further with 
the database. Double check the information you have inputted against the hard copy to look for 
mistakes.  

If you find that you are constantly making large mistakes, consider whether your working practices 
are preventing you from achieving your potential. 

You may have to look at: 

 Your working environment 

 Your concentration levels 

 Any distractions such as people within your workplace. 
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Organisational requirements 
Be aware that organisational requirements will vary from company to company. Try to take note of 
any company goals which may affect your deadlines. For example, if an important trading period is 
approaching, you may be required to meet deadlines sooner than usual. 

Take into consideration the company’s level of technology. Newer software may increase your work 
speed, while older technology will reduce it. If you don’t believe you have the necessary technology, 
inform the company.  

3.2 – Use manuals, user documentation and online help to overcome 
problems with database design and production 

Overcoming problems 
From time to time, you may experience problems with databases, such as inadequate software, 
malfunctions or lack of knowledge, which will affect your ability to complete your work. You should 
try to use various methods to overcome them and meet your deadlines on time. 

These methods may include: 

 Manuals 

 User documentation 

 Online help 

 Colleagues’ help. 

Manuals 

Most software and equipment will come with manuals, either in paper, digital or CD form. Whenever 
you receive one, you should read it even if you believe you are already familiar with the software or 
equipment. 

Store this manual in a safe place once you are finished so you can consult it when problems arise. 
The manual may include a list of common problems and how to solve them, as well as an installation 
guide. Online manuals will also include more recent bugs and fixes, which you can find by visiting to 
the manufacturer’s website.  

Manuals are a useful starting point when trying to solve a problem in database software. However, 
the effectiveness of a manual is usually directly related 
to the competency of the user, and may be out of date if 
it is on paper. 

Third-party user manuals are also available for many 
pieces of software. These are tailored to both beginners 
and advanced level, so you can purchase one that is 
applicable to you. Also books serve different purposes, 
so don’t assume just one book on a programme will be 
sufficient. For example, to adequately solve problems, 



P a g e  | 27 
 

you need separate books on getting started, troubleshooting problems and understanding the 
software’s advanced features.  

User documentation 

User documentation describes what the product is capable of, such as its features and functions. It 
may also offer tutorials to educate the user on them. Once again, it will often arrive with a product 
or be available online later.  

Consult it if you are unsure whether the software you are using will be suitable for your purpose, or 
if you wish to fully understand a new feature.  

Effective user documentation should include:  

 Current terminology 

 A list of applicable error codes 

 Descriptions of all toolbars, options and menus 

 Images and diagrams, if necessary 

 Lists of functions 

 An explanation of acronyms or abbreviations. 

The organisation may also provide user guides explaining the specific functions you will need to 
understand in order to perform the role correctly. These documents are important for on-the-job 
training. They will likely not go into depth about functions that aren’t relevant, so in the event of a 
problem, you may have to refer to another source of help.  

Online help 

Online help can be available in several forms, and is usually sorted by topic or problem. 

Help may include: 

 Manufacturer’s websites 

 Software help functions 

 Web chats 

 Help forums. 

These may be of varying reliability. For 
example, checking relevant information on 
the manufacturers’ website or chatting with 
an employee should provide you with 
accurate information; however, when using 
help forums, you are relying on the guidance 
of strangers. Treat advice with caution and 
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do not follow it if you believe it may harm your computer or software.  

However, you may also receive advice that would be unavailable from the manufacturer, and may 
get a quicker reply.  

Software help functions may also have information on 
your problem. For example, Microsoft Access has a 
help function for common problems. To use it, press 
the question mark icon in the top-right corner of the 
screen or press F1 while the programme is open. This 
will open a window in which you can search keywords 
relating to your problem. It will then provide tutorials 
and links to helpful information.   

Colleagues’ help 

If you’re working with colleagues who perform similar 
roles, you may be able to ask their advice and use their 
expertise. Once again, the accuracy will vary 
depending on their level of experience and knowledge.  

To ensure you can receive help whenever needed, try to reciprocate if they encounter a problem 
they can’t solve. This exchange of knowledge will make the workplace more efficient. 

In addition, your company may have an in-house IT department that will offer help free of charge. If 
so, they will offer help as soon as possible, although they are not guaranteed to have expertise in the 
programme you are working with.  

Outsourcing technical help 

In extreme cases, you may consider outsourcing problems to an external IT company. These are only 
used as a last resort due to the high fees. You will have to pay for the time spent on your request 
which could be expensive if the problem turns out to be complex. However, in most cases they will 
provide quality service, saving the organisation time. 

3.3 – Preview, adjust and print database reports or forms in accordance with 
organisational and task requirements 

Database reports 
As mentioned in earlier chapters, you can use either the Layout or Design views to make changes to 
a report. Layout view is most effective when changing the visual presentation of the report, such as 
rearranging and adjusting the size of fields. You can also apply pre-made styles from this view. 

Design view, by contact, offers more control over the functional aspects of the report, such as the 
structure. While you can’t see the data, you can see the header and footer sections. Editing text 
boxes, labels and images is easier in this view. You should change between the views whenever 
necessary to make full use of the functions of Microsoft Access. 

There are a variety of ways to preview a report before printing in Microsoft Access: 
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 From any view, press the File button in the top left hand corner and select Print 
Preview 

 Right click the document tab and select Print Preview 

 If the report isn’t already open, scroll to the Navigation Panel, right click the 
document name and select Print Preview. 

This will allow you to see how the report will look when printed as opposed to on the screen. It will 
help you to judge the overall look and feel, which may cause you to make changes. Consider 
whether the information is spaced appropriately, the correct font size is used and all of the 
information is visible. Always preview a report before printing it to verify the accuracy of the data 
and the report.  

You can also use the Print Preview view to adjust the layout of the report, such as changing the size, 
margins and orientation of the page. You can adjust to settings to view more than one page at a 
time, which may be helpful if you are working with a report which goes over multiple pages. From 
this panel, you can also export the data into another report.  

Some companies may suggest or require the company logo to be on all reports. To add this, open 
the report in Layout View and click Logo in the design tab. Use the pop-up box to find the saved 
image on your hard drive or serve and press Open. It will be added to the relevant pages of the 
report. 

When you are happy to print the document: 

 Click File at the top left of the screen 

 From the drop down menu, select Print (or if you don’t want to change properties, 
click Quick Print) 

 Ensure the correct printer is selected, along with the number of copies. (You may 
also have options about single or double sided sheets) 

 Once you are satisfied with the options, press OK.  

Your organisation may have relevant policies about printing reports, such as whether or not you 
should use colour and whether reports should be double sided in order to save paper. Also consider 
how many copies you will need; if you are presenting them in a meeting, you may need a copy for 
every person attending, or if that is impractical, enough so that all people can see at least one copy. 
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Themes 

Themes provide formatting options for reports and forms to provide a consistent experience. This 
makes them more visually impressive when printed out. They are customisable and can be shared 
with others. This can allow a company to create a trademark theme, and since themes are available 
on all Microsoft Office products, they can be applied it to all documents it creates. 

 

Normally, themes are applied across a document. To apply if to one object in it, right click the theme 
in the menu.  

Themes are located in the Design View. On the Design tab, click Fonts, then Create New Theme 
Fonts to customise your own design. To save it for later, click Choose Themes and then Save Current 
Theme. It will be saved as .thmx file inside the Application Data folder.  

 

 

3.4 – Name and store databases, in accordance with organisational 
requirements, and exit application without data loss or damage 

Naming databases 
You should have named and saved your database while creating it in case of a sudden loss. 
Important documents may also warrant a backup that is updated regularly. 

Your company may have requirements about naming documents, especially if they are to be shared 
with other staff or costumers. 

You should try to: 

 Be clear about the report’s role (e.g. End of Q1 Analysis) 

 Differentiate it from similar reports, for example adding the date to it 

 Use a version number when it is an updated copy of an older report 

 Use a code it if you have been given one. 

Correct naming procedures will allow you to find the report easily in the future. It will also inform 
other people what it is, which may prevent it getting accidently deleted. Simply calling it ‘Database 
1’ sounds unimportant and doesn’t provide any information on it. 
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Some companies may follow established guidelines, such as the Leszynski/Reddick Guidelines for 
Access. This suggests that all databases should have a descriptive tag at the start.  

For example:  

 A form about imports becomes ‘frmImport’ 

 A report about customers becomes ‘rptCustomer’ 

 A table about sales becomes ‘tblSales’. This allows consistent naming. A full list of 
Leszynski/Reddick naming conventions is available here: 
http://access.mvps.org/access/general/gen0012.htm 

However, even if your company don’t use an 
officially recognised naming convention, you should 
use a convention. Use one that makes sense and is 
effective within your organisation. 

 
File extensions 

When you create a file, it will automatically be given 
an extension. This will determine how the file is 
saved and which programmes it can be opened by. 

For example, saving a file in Microsoft Access 2010 will give it an .accdb extension. This will prevent 
it from being read or opened by earlier versions of Microsoft Access. If you wish to use it with earlier 
versions of Access, you should save it with an older extension.  

Earlier versions use a .mdb file extension. These can be opened in Microsoft Access 2010 but you 
cannot use new features that require .accdb extension. 

File extension Type of file 

.accda Microsoft Access 2007/2010 add-in file 

.accdb Microsoft Access 2007/2010 database file 

.accdc Microsoft Access 2007/2010 digitally signed database file 

.accde  Microsoft Access 2007/2010 compiled execute-only file 

.accdp Microsoft Access 2007/2010 project file 

.accdr Microsoft Access 2007/2010 runtime mode database file 

.accdt Microsoft Access 2007/2010 database template file 

.accdu Microsoft Access 2007/2010 database wizard file 

http://access.mvps.org/access/general/gen0012.htm
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Storing databases 
When preparing to store a database, consider: 

 Any security precautions needed 

 The organisation’s policy for creating backup files and hard copies 

 Who is authorised to access it 

 How sensitive the information contained is 

 Whether physical copies should be made on CDs in case of computer problems 

 Which specific folders it should be saved in 

 How big the file is. 

Choose a location that is appropriate for the level 
of security the database needs. For example, if it 
includes information that is freely accessible 
within the company and needs to be accessed by 
several people regularly, saving it to the 
organisation server may be appropriate. However, 
if it is a larger file or shouldn’t be freely accessed, 
organisational requirements by suggest saving it to 
a single computer, a memory stick or a CD.  

Ensure there is always a backup somewhere so lost files can be recovered. Backups are also useful to 
restore a database to an earlier version. Remember to update backup files whenever you make 
changes. This will allow you to restore an entire database or selected objects. Some products may 
automatically create backups to improve efficiency.  

Managing backups is important for the smooth running of a company. If the list of backups grows 
too much, consider archiving the older, less relevant ones to save space and make it easier for 
employees to find the one they are looking for. 

To backup a database: 

1. Have the database open 

2. Click File or the Microsoft Office button in newer versions 

3. Click Manage, then Manage this Database, then Back Up Database 

4. Enter the name you wish to save it as. The default name will record the name of the 
original file and the date of the backup, which would be helpful to remember it 

5. Chose the location you want to save it to. This could be on your computer, a 
network, a memory stick or CD 
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6. Click Save.  

Physical storage 

It is always advisable to store backups on the database in a physical location, such as a memory stick, 
thumb drive, CD-ROM or external hard drives. This way, if the organisation’s computer network 
experiences severe problems or the database is accidently deleted, the backup will be unaffected. 

When planning this, consider talking to an IT expert who will be able to advise you the best way to 
do this for your organisation. For example, if you produce a large amount of data on a regular basis, 
investing in external hard drives may be more cost efficient than dozens of memory sticks. Ask for 
advice on compressing databases so they can be stored easily.  

Also take into account where the physical backups are going 
to be kept. Memory sticks and thumb drives are small and 
easily lost or mixed up. If your organisation chooses to use 
them, a labelling and cataloguing system might be required 
to record where they are at all times. CDs are also easily 
scratched or broken unless they are stored correctly, and CD 
drives are seen as less essential in computers nowadays. 
Therefore, they may not be as future-proof as other 
methods. 

Remember that backups are a method of last resort when 
the original is no longer accessible. If you create a backup, 
do not assume you can delete the original as you then have 
no insurance if the backup fails. Keep at least two copies safe 
at all times. 

Splitting a database 

If a database is shared over a network, splitting it can make it easier to maintain. It will prevent 
corruption or unwanted changes by other people working on it.  

Splitting it will produce two files: 

 The backend file that stores data in the tables 

 The front end file that stores the reports and forms.  

These can both be worked on separately. Splitting a database will enable you to store them in 
different locations or on different networks. It is still advisable to back both files up. 

This method is useful when many people are working with the same data. By saving the backend to 
the company network and giving users access to the front end, many people can use the same data 
without fear of overwriting each other’s work. It also allows a new front end file to be created 
without modifying the entire database. 

  



P a g e  | 34 
 

3.5 – Prepare and distribute reports to appropriate person in a suitable 
format 

Distributing reports 
Once you have finished, saved and printed the report, consider how you will distribute it to the 
appropriate people. This will depend on the setting, the amount of people and the use for it 
afterwards. 

For example, if the report will only be seen by your supervisor, consider which format will benefit 
him or her most. It may be that they would like a digital copy to be emailed to them. Alternatively, 
some people prefer paper copies to make notes on and annotate. Learn people’s preferences and 
ask what format they would like if you are not sure. 

Formal presentations may require numerous copies of the report to distribute. Find out how many 
will be needed and prepare them beforehand. You may wish to email the databases to anybody who 
requests them after the meeting.  

When printing reports out, take care that the finished product reflects the work that has gone into it. 
Hours of work and preparation may be undone if the paper copies look creased with the printing 
smudged or blurred. Presentation is important, so ensure it meets your organisation’s standards. 
This will be particularly important with members of management or external clients and customers. 
If the report goes over several pages, consider stapling them neatly together to keep them in order.  

If you aren’t sure about the format for reports to be distributed in, check your organisational policies 
or consult your supervisor.  

Highlighting points 

Seeing the report on paper, you may decide to make changes to draw the audience’s attention to 
important points. Conditional formatting is a useful way of highlighting values based on certain 
conditions. 

For example, you could condition data to become red when it goes below zero, or bold when it 
exceeds a certain amount. The specifics will depend on the requirements of the report and what you 
wish to highlight. These will only affect how data is displayed and not how it is stored. 

To do this, click on the object you want to apply the formatting to, holding down the CTRL key if 
there are multiple objects. On the Format tab, click Conditional. This will open a pop-up box which 
will allow you to set the type of formatting you want and which conditions you require to meet it. 
You can add multiple conditions as long as they don’t conflict with one another. 

You could also use data bars which show visual information at a glance. Length of bars will 
immediately show the values of the data which can help comprehension and identify trends that 
weren’t immediately obvious before. 

If you decide to implement these changes, you will need to go back into the database and repeat the 
printing process.  
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